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MBI IETEA] ESM7000 241 T4 FE M.

N T ARSI P A BATH ™, SR A RIS TIXR (A3, AT
B AL A0 P AR 0 E —akg . FATAE B SR EN, H2 I8l R AR
KT REE AR RS0, DET T RED 1 130T, ka5 o™ i 1 A

FEAR L G 7 St AT ST I A A A b, SR A28 380 A iy VR 75 23565 By, ST Lo s A
=5 TR IEA) TR AR S FF -

1. HEE%H 028-86180660 85140028
2. RIEWA B AR L FRIBHE support@emtronix.com

3. B FEHAMEE www.emtronix.com, FEFRARBIE FEESE N

T3, ATFMUL S RBOR RS . BURME AT DUOE I 5 61 kYl T 4
E: RAUAXNF LR R EATFMOAAXRERAE, FHE P EFHAN S AT RRHN
WAGFHE, BRFITEL

PR U B SR
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H K
O ] 1Y I 0100 X TR 3
2 FEETEIETF IR TG oottt 4
2.1 ESM7000 FFRIAEEAETEI cooovoeveeeeeeeeeee e st 4
2.2 ATEIIHESD oottt ettt et 4
2.3 FFRIFBEHITIAEIERERAIZEBE et 5
I =17 3O = AU 9
T === = OO 9
3.2 G USEIINTOIXE SUA oottt ettt ettt eens 11
3.3 fHF EClPSE ... 13
3.4 eclipse FEIEFE L CHHRLH TR oot 16
3.5 eclipse THiiF CHHIL LR oo 24
3.6 BB IERGIFEE oot 27
O VR Y T e i = I I 2 VTP 30
4.1 B TIGRFRBE I BRE oottt 30
= A £ b /1 [T 31
e oy e o i 1 R W 01 = 2 TN 35
5.1 TCP SOCKEE TR .o.vocvveeeveeeseieeee ettt sttt sttt 36
5.2 STEFZIEREN TCP HRES BTN oo 36
6 NAFEFEIRFETEHNZ =t TCP 2 M creiieieeeeeeeeeeeeeeteesesesesss st en s ensansenees 40
6.1 TCP %)t SOCKE Zi AR covvveeeeeeeeeeee et en st 40
6.2 TCPCHENE BL IR .ot 41
R R N = s = OO 46
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1 ESM7000 f&j4r

SRS KRS SRR AR 7= : ESM7000 R4 T4 F4K

ESM & B 96 A 7] K (1 — B N AR 5 R AR R FE NS, 7 D B R AR
ZEK) (Emtronix Smart Module Architecture, DL RfEi#k ESM ), ESM7000 £ %1 T4 £k
G5 LA ESM FITE I — 3K B i

ESM7000 % %1 2 # 2 I [ ok 4Tk 1) v 1k O e iR N 3K AR, BANXP ) A%
Cortex®-A7 {KINFER F iIMX7D AFLAE %0, ESM7000 85 7% 56 B 1 R 40 4% 11
SRy, AR PR T AT B A Al A0 & . H AT ESM7000 1) i 4% 1
Linux-4.9.11 RGF&, H R RITIH, 7R A RS A1 Eclipse SERIF K
R (Linux JA) 50338 1d Makefile 45 Linux TR FI 2 45 B30 T FRA 1B AL A0 S8 X g 7%
BT H, Hgm e s AR AT B2 1T 5 ESM7000. el AR 4F%T ESM7000 #2441 588
(4 IR Z IR BN LR I R R e ), B P AT R e b0 (68 L PRI 2 % o 4%
7t

ESM7000 JF & HFEA SCRS (04 -

(ESM7000 T 4% EMR LAY —— ESM7000 HIENTTF M, BUCH % #w i —

5

(ESM7000 H & T. 2 %%:) —— ESM7000 %8 X g T 2223 F M, i

(ESM7000 TiEMREIEFM) ——ESM7000 321158 X\ B DL & & 4 AR 45

(ESM7000 T.1% FH LS L TM) ——ESM7000 ThfERE D48 FH 7 v S A4 e i
i
(ESM i PPl IR BHE F ) —— £74 ESMACR FUVE AR A -AN JEAR 45 FH 3 B
ESM7000 1158 £ % Bl f1 i B 3% 2% ESM7000 JT & 6 25 F18 5% RAT (9 R 3

http://www.emtronix.com/product/ESM7000.html.
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2 BEEHFTRTE

2.1 ESM7000 FF R HEEA DA

FP 55— XA ESM7000 fEAE R KIT RV &S, JFR PP BRI T JLE 5

ESM7000 THER—H: NXP iMX7D A¥E#:, ik A Linux-4.9.11 5L £
RS8R S, HOTEES

ESM BAFF R IPE R —B: #5230 ESM7000 F5] IR E TR A B T
ESM7000 A BB IRIARHERE 11, BRJ7 R X ESM7000 BEATPPAS AT/,
SCH P RAMNE R R IR B —E 25

BB O —a: 3 2kl f R, H T ii(E e

PAIKP R — % FLET 3, T HET BAsHLR G 00 & B 44 DL I R M 2% D7 TH
F B FH Tl g

USB ##ELZ—%: A-BIERL, HTHITRGARES
HRBIFEELE—%F: B0E, +5V, HT RS
FERBRDCR—TK: AR BT RS F & s 1 Bkt

WRAE = T R AR K, B 7B — 2R PP R B B4, 257 il gk

AR TR, e

BRI ARG, W43~ (480x272). 7 ~) (800x480) 4%
ORI e O BRI AR . AD I R AR B A4
GPRS/CDMA JEIMEEL (f1: Siemens MC37i R3) LA Kz R 2R &5 [t {1

T N B A

RIS F R BCE A T35, 22512 a0 U0 R BT

2.2 DERHESL

M ERI A ESM7000 AT P A, 7 BARANT —deah B
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o EF—HHA+EV R 1 I8 B IR ST R B YR (+5V45%),
TSR B FVR R IER R B Z B IR M +5V B b GERARMED.
® Ji: 4R4E ESM7000 #9%& kK 43t 3, A b P By sk, HHUR P Bl o
£E 20W (5V/4A) U EHF (LR,
® % — A LUK USB #2111 PCHUEAFF & ML, 1% PC Bl %% 64 47 Linux
HAE RS
E: 1. AREOTRMER usb # & o iR#THE, AR, RNELEPFRER
Rk A% E by PC AR FF K EH.
2. BT X BiFT LN Linux 64 42049, FTAR P & F4ER 64 4% Linux
A%, AR Windows ERPbLeE Linux & 4.
o iR —BMBIER I (SRR HAD.
® ey — HnItim i AR U AL,

2.3 JERIFBERIBEA A 225%

FECL E2RAFER AT LUG sl AT DA% a0 5 BEAT T A AR O RE AR 342 1

1. ESM7000 H 4 #A =HEEEEE (CNL A1 CN2), XK ESM7000 FrAR
USRS, TOIF A PP RAR b 22 A A0S B A = HHdig (CN1 AT CN2), ESM7000
R AR —FERHEE R VEARAR L, AT — BRE BT R R 48, W T R

E: AR P KBS FFKREE T, ESM7000 2422 AT KRG RKR L, FRE

PR P ERITHER, FEEEFREROF TR,

CPU Moudel:IDC female
Carrier board: IDC male

PRI T MRS TF A IPAL AR AR R

2. ESM7000 A Fh TAER: B A7 B.
AR X Z I LLE R G TR BCIRA,  Sbmr A P mr DL i B 2 2% o oK # 1

Www.emtronix.com 5 028-86180660
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ESM7000, eI AR PR, XHEHEINRE. EFRME, R REATIXFRR
=x=

BN o

AT AR IR IHLLLG R4 B ST F P 4a e IR 7« FF R 5ERG, BEN SEFR B
RIS T IXFRES
ESM7000 TAEF ik fml—Fifgist, s kil Rk b sk sy IP1 SRk Fm

(IPL FETF R PEAl AR LA BRI B LR BD . IPL g, W TAE TR IPL Wit
W TAE Tzt

-0)01d9 OINJ

LA PR 4% IP1

3. BB rR E TERR LR P i 2 A AT A LN H AT ESM7000 JF A DFAl R AR (1
EHEH O, WS,

R R

4 FH AT AR RS B L/ H 23145 28 250 E AL ESM7000 A — AN, 1 R B AR

Www.emtronix.com 6
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XRETF R EHLF ESM7000 5t BEME FE 37k W 25 7 4%

7: ESM7000 # ip bt — R £ 5F £ £

MUY ip HehiRE AR —RBEA.

|

,‘ab
=
5

Iy
e
&=
=
=

¢

FFE R ENLFT ESM7000 32\ BLK Y

5. WERMPAESLEISE T Bosbe, w LR E RBE 40pin BHFL ELGE LS ESM7000

PPAL AR 1) CN16—LCD EonE Mo G H P IE L2 VDS B BoRbF, 15 5EREFITHL K
M) CN15 455, HDMI & #2101 CN6.

%EH LCD

2 It, ESM7000 iz17 B FEA -4 D48 13 e il

E: USB £ BN ZAZCVRF TREZLAAE, E2RAFATRSHNRESER.
AR ABIRE 7 Aim A AR T RB RS LA L,

Www.emtronix.com
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PIAE A LAZS ESM7000 i@ HL, BlKE+5V B B YR 24 Sl 28 JEE A B i B s =k (il
7)) B, i, ESM7000 b 4r i LED 54T =
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3 EEBHFRAE

ESM7000 #i# ik A3 Linux-4.9.11 sEI ZAE 5548 4F 248, F 7w LIZE PC _EAEH] Linux
BAE RGAT AR T I K. T Windows #(E RS2 H, i - P, EdE
HOFAH B QRN FHFERE, 522 Linux B B9 TRUARS 77, 908 A Rl BT 1 K& B A K
RO TAE, BT — R AW LAE Windows #:1E R4 IF K Linux MR, LT
N EEF] ESM7000 FzAT AR TR, NEARIZE AR TR 2R 7R UL R
FOE, ) ERBEAC B D BRAD AT PR RS i ESM7000 AT AT 6 .

3.1 RESOTH

ESM7000 Wizf7fE B i@ s 0 TR BRETF R ENM L REE B B B Zx
ESM7000 S R G 0EAT #1175 i o i 4% 24 iy DA iy 247 77 :Uk4T . ESM7000 F i/ i
HERNE A 115200, 8N1, no hardware flow control (o4 i)k sl . Linux K%

FH I & DA% minicom, #8840 B3R5 E minicom:

Www.emtronix.com 9 028-86180660




BRI B ARG R A A ESM7000 .45 3t i FH st

1. BT A HE & E S sudo minicom -s

2. % Nk Serial port setup, F#[H 224 HE N B G B S

| T [configuration]—---——- +
Filenames and paths
File transfer protocols

| |
| |
I serial port setup |
| Modem and dialing |
| screen and keyboard |
| save setup as dfl |
| save setup as.. |
| Exit |
| Exit from Minicom |

3. FEEATHIE RS PR G I B T, ik ABCE S D, FR T Serial
Device 5 ZARYE B LAY HLINR I E, HARIUAS R 280 E BT T BRI

A - Serial Device : /dev/ttysSo

c - Callin Program

D - Callout Program :

E - Bps/Par/Bits : 115200 BNl
F - Hardware Flow Control : No

G - Software Flow Control : No

Change which setting? []

www.emtronix.com 10 028-86180660
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4. ERRLLE% ESM7000 [, &l Eon it ESM7000 AR SIER . JE3)
I UL 18] 2233 N\ A 247, BRI o] DL i 8 2% 24 Linux 14y 2% ESM7000 #3E17 #:1E .

box : sudo — Konsole
SHHF) YREE(E) EE(V) BE(B) WES) FBiH)

U-Boot 2015.04-svnl4 (Feb 20 2017 - 17:57:25)

CPU: Freescale 1.MX6DL revl.3 at 792 MH=z
CPU: Temperature 48 C

Reset cause: POR

Board: MXEDL-ESM&802

I2C: ready

DRAM: 1 GiB

PMIC: PFUZE100 ID=0x10

MMC: FSL SDHC: 0, FSL_SDHC: 1, FSL SDHC: 2
Video ouput is LVDS+HDMI

Display: LVDS (1024X768)

read bmp filel

In: serial
out: serial
Err: serial

switch to partitions #0, OK

mmcZ (part 0) is current device
Net: FEC [PRIME]

Normal Boot

Hit any key to stop autcboot: 0
switch to partitions #0, OK

mmcZ (part 0) is current device

** Unrecognized filesystem type **

MMC read: dev # 2, block # 14337, count 16384 ... 16384 blocks read: OK
Booting from mmc ...

MMC read: dev # 2, block # 34817, count 400 ... 400 blocks read: OK
Kernel image @ 0x12000000 [ O0x000000 - 0x60a240 ]
## Flattened Device Tree blob at 18000000
Booting using the fdt blob at 0x18000000
Using Device Tree in place at 18000000, end 1800e848
arm orig pod0
switch to ldo bypass mode!

Starting kernel ...

[ 0.000000] Booting Linux on physical CPU 0x0
[ 0.000000] Linux wversion 4.1.15+gd5d7¢c02 (box@LGZ-LINUX) (gcc version 5.2.0 (GCC) )

ESM7000 #43 JE shis B

3.2 %m%E userinfo.txt 3Cf4

userinfo.txt XA = MEH:

1. A& ESM7000 [/ 424, ik ESM7000 571 & LA T [Fl— M Bt

2. BCE NFS H:HZHL TR ENKITEE H e 8E ESM7000 HIFEE H % H

3. BLEMNHEFSE, XFEIFRFEIE ESM7000 4 H shiRHE Z S 53T B FE T

Www.emtronix.com 11 028-86180660
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ESM7000 T 4% 3= A4 FH 06332

userinfo.txt TP P2 LA ST OBUREER JE AN R 5 PRI € 1) S D I £ 35 W3 S
T JFAVBAELE userinfo.txt SCAFH, =7 SHIEERAEHK):

[LOCAL_MACHINE]

DHCP="0"

DefaultGateway="192.168.201.20"

IPAddress="192.168.201.90"
SubnetMask="255.255.255.0"
[NFS_SERVER]

IPAddress="192.168.201.85"

Mountpath="/d/public"

[USER_EXE]

Name="/mnt/mmc/hello"

Parameters=

Www.emtronix.com

/I ESM7000 4% &

/I Bt E DHCP %& P 3545 & & A “0” ] DHCP X
I, APEFHERERX, IPkit, FTR&ED;
Il & #“1”R DHCP # /&, ESM7000 # & 473k

Il £ R % 5%

Il BRINR X, ARER PFATEGERBEITRERE
/ ESM7000 &9 IP 33k, Al P B4TRE

Il F R, R3ER P ARG EIREIT MERE
/I NFS ##42 &

Il FrREHIP ik, ARAER P PR 6 K FREST
Il ML E

Il FFREMERERG IR E, AP

Il “public” A4, AP TaiT#HBEE A4 X,
Il &R LM LA B2

Il B PAERAE &

Il AT A SHPATHEF R L EHBEZ, TR
I TRABER PR BT RARR LA
I 23] 5 Z B BAX, B AT 69 BRIA S A%, FFALBR T
Il a#hiafr (&, APaTE

Il Imnt/mmc/ T 2T B ZEXL LR,

Il BB 2AASH G — 2 B Lt sk iz)
Il ZRFMASHPITHREFGSKTE. FAT
Il BOAG SRR NE IR AR 053, %
Il AR, 1BLIRREGRE]5

12 028-86180660
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AR F P () SE BRI 2% 2 5 B 4T userinfo.txt, f£A\ U £, # U 82\ ESM7000 &
PR A USB #2101, 4H$% IPL ffi ESM7000 4 Tk, A5 B, RE0H HEhER
USB # 1, K B userinfo.txt SCAEAZ R Imnt/mmce H 3%, 34% I8 H 4 25 i & ESM7000
M2 S5 BahseblE, T LOE g & fEH ifconfig iy 4 £E & 5L & 56 k-

userinfo.txt 5 A\ ESM7000 PLJ5, REGRERITFHLIA S B B3 BU0Z SO I 428 Sk A 253t
ITHCE . R TS HEFR EENICE, "T9miELT userinfo.txt 7 8E 2 4T ik DR,

MR RGFHLE ZIHEE, W ESM7000 S )2 B 4045 4T WIinNFSd.exe.

2R ESM7000 AEFizATHi, WIFHLELE & B 3h#hdT Name="/mnt/mmc/" T3 B
SRR o S0 43 BC I A7 L [ 8 FE fmnt/mme SO TR, B AT RLKE RS B
PAFAERA H g, AT BAESE H 5 N1 H AP S AL o I IC B AZ IS K I
Tl BT ERAR, N ARG TR BHAT S

E:Linux #EZAPHE S KDE, Bisb 6 R P 8 AARF L REME FIRGEF

LR E—H, BHERIEFE.

3.3 f¥H eclipse

eclipse /& — I % 9 17 BRS04 & TR, 5 Windows & A&
T H4n Visual Studio #:4F ELEERAL, BT AFRATE 11X eclipse 47 722, J7 AR Linux
BARIT R Z PR seAh, AP AT B T EARE LK) C 5 AR AL Linux FiEER
BEATORARTTTHI A% 2] o A T34 Linux JafRRH 7, af DUEH B S m 77 ks
automake. Makefile. CMake %5) BEATEMFIT A, W BB 22363 HAG I FRA TR AL 52 X
Y T HEERITT. Eclipse DA X 4mid T RN 23 CinE (ESM7000 FFk T R 22 4E)
HEHTVEAIRUE, W HATS %, FEHAHEGA.

FEF R Linux BIREREIT R, — B bhan 247773, HE Makefile S0, 48
JGiE make THNKIZIT GCC, S FEF I g BEREREIN . IX Mg i T TG
A8 Linux P2 FH Y FEL 52 200 24 RO BRI, AR5 1) X 5 AR g B S 755 (0 /A b SE 2 dn ko 17
LK H eclipse I, F P OANF 7R 20 41 Makefile SIS, ATHERE 7188 Hh 78 R

Www.emtronix.com 13 028-86180660
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REFFAS S SCBLAO DI RE L, TR ER 7 N IR A (KT A2t L

‘245 Eclipse LA 7E & T HAHEN eclipse X132, A4 ‘Jeclipse’ Jazhiift,
F AT CAE BINER 7 300 A RS B RS S, W E R
I

==z cMtronix

< eclipse

#7590 7S B eclipse J3 30 [
IR B RIEHE, f5 8 TR S ERN R 42, S B i eclipse & it (1)

AR E B RAF B R . A3 Bl/home/box/workspace A, R HATHEE
EREE R AR TP AN B AT T A

Www.emtronix.com 14 028-86180660
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Workspace Launcher x

Select a workspace

Eclipse Platform stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

Workspace: ‘ home/box/workspace v Browse...

Use this as the default and do not ask again

Cancel OK
R TR SR AT B AR
Ja#LLE, #EX Workbench, W1 FEAIR.
Resource - Eclipse Platform x
Eile Edit Navigate Search Project Run Window Help
@ Welcome = @ @ & A = & 5

Welcome to Eclipse

% Overview Tutorials
Get an overview of the features ' Go through tutorials
@<> Samples What's New
o Try out the samples Find out what is new
@$ Migrate

Migrate to the new release

ik N\ Workbench

Www.emtronix.com 15 028-86180660
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3.4 eclipse TRIEMEHE C++NHTRE

FEREAT N RE P E s AEAE 2 ARAE A R ) D RESE B A% P &) 73 1l 22 MR HOR AT 8
by TR HORT R NSO, IR A TN R R BN, X TR 2 M
R Ry A P 1) A8 B — MR S o B R SO HEAT 1, TR — AN L PR e X 22— B
TR AREERELANHCIE. o SIEN AT TREXFNIE, X eclipse (1
I HEAT VR UERA

XA Linux SRR IR, TP AT B4 i TRE SO/, vl R A B TR
SCAFRAT L ERNENL RSN RE P IIIF A -

U — AN TR
1. QI IR, 2% $E File -> New -> Project.. RSCHLHT, FATEK
ik C++ Project, 1 FE AR,

& C/C++ — Sourcery G++ IDE

SO Edit §ouce Refac;or Havigate Search I_iun groject findow Help
Open File. .. [E¥C Project k
o Tyl fJ Project. .. !

j [Co] Convert to a C/CH++ Project
Ctrl+S 2% Source Folder
("% Folder

Ctr1+Shift4S | &‘J’ Source File
‘ L'l‘l’ Header File
| g’File from Template

Rename. . . F2 ‘ G Class
& Refresh FS | 3 Other. .. Corl+N
Convert Line Delimiters To "
HENLHIN CH++ LR

Www.emtronix.com 16 028-86180660
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2. BT OREIN TRE SOOI 2 FR LA B 47 B Bk AR, 7EiX BN ELE F R G E
FRAE, TMAEIEREFH P EHATEALH Linux N AP R R, DMEFR AT RS, R)5iE
# Project type: -> Executable -> Empty Project. LA hello world {5 i1 B ffin .

C++ Project

C++ Project —

Create C++ project of selected type

Project name: ‘hello|

[B] Use default location

Location: /home/box/computer/workspace/hello Browse...

Project type: Toolchains:

® Empty Project

= Hello World C++ Project

+ & Shared Library
+ & Static Library

+ & Makefile project

[®] Show project types and toolchains only if they are supported on the platform

@ < Back Next > Cancel Finish

% Toolchains

3. M Next BN B E S, X T ESM7000 SRk, X L6k B 50T LLSEH g i
H.

4. SN B R Finish, — N TR L8R T .

T EA IR

1. i%&#% File -> Import..., £ General [i&#f Existing Projects into Workspace,
W E R,

Www.emtronix.com 17 028-86180660
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Import

Select

Create new projects from an archive file or directory.

Select an import source:

type filter text =

- &= General

& Archive File

# Existing Projects into Workspace

T File System
ElPreferences
+ &= C/CH+
+ &= CVS
+ = Git
+ &= Install

+ = Remote Systems

@ < Back Next > Cancel Finish

TP CA I TRESCA

2. sy Next, i#id Browse... & C AR TR EH S, )5 A Finish $T7FE
W R Stepl_LCDTest M L2, W FEFTR.

Www.emtronix.com 18 028-86180660
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Import

Import Projects B

Select a directory to search for existing Eclipse projects. =

@® Select root directory: /home/box/workspace/step2_serialtest Browse...

Select archive file:

Projects:
[H] step2_serialtest (/fhome/box/workspace/step2_serialtest) Select All
Deselect All
Refresh
Options
Search for nested projects
Copy projects into workspace
Hide projects that already exist in the workspace
Working sets
Add project to working sets
@ < Back Cancel Finish

B TR SCAFIFATIT

I 3T FO YR SO
£ Project Explorer #L & N8 75 LA NG SOOI RS, AR5 sl AR A B, 163 New
-> Source File 5# New -> Header File, BTN CPP ol H U/ #1i% TR .

G’ e B CPP SCAFEE H SCH )5, 7T LB SR H File -> Save s ilid # Ctrl+S
BEHEAT ORAT -

e A XA

Www.emtronix.com 19 028-86180660




H OO B AL RAR ESM7000 L #% 1 fi it /i 2 ¢

1. 1 Project Explorer #L & F, EHEFERINCAFE SR TR, SR5 St Rbs s,
%&£ Import..., %&£ General -> File System, 1T E iR,

Import

N\

Select \d

Import resources from the local file system into an existing project.

Select an import source:
type filter text

- &= General
& Archive File

& Existing Projects into Workspace

Tl Preferences
+ & C/CH+

+ = CVS

@ < Back Next > Cancel Finish

IINEA B

2, AT AT SCIFRIERE W EFTR

Www.emtronix.com 20 028-86180660
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Import
File system B
Please specify folder -
Fromdirectory: /home/box/workspace/step2_serialtest ‘ N H Browse... ‘

= & step2_serialtest W= .cproject
OE& .project

[ serial.cpp
[®] 2 serial.h
(W] 2 step2_serialtest.cpp

Filter Types.. | SelectAll | Deselect Al

Into folder: Browse...
Options
Overwrite existing resources without warning

Create top-level folder

Advanced >>

@ ‘ < Back ‘ Next > ‘ Cancel Finish
P FREIN IR A

Www.emtronix.com 21 028-86180660




E LOERBAGRAH

ESM7000 T 4% 3= A4 FH 06332

il s

MR TR SO R DRSO b AR niB, SRk #¢ Delete, 4R B,

E:]—Pr_oiect Explorer ;% J
st 7 i .

el @ stepd_tepclient. cpp

Www.emtronix.com

M AR S

22

BS| % ¥|  )TCPCLIENT_INF
# =5 hello
100 LCD_APT
1 1lstartup
i JEEREEREREEREE
= | - pim
. Hew 2
[#-1= Ste :
1 Ste [ copy Ctrl4C
-l Stq ey A
B LE Faste Ctrlty
#-1= Ste .
2 Remdve from Context Ctrl1+Alt+Shift+Down
Mo ]
Rename F2 ¢
1
2y Import. .. A(
iy Export. ..
Open Project ]
Show in Remote Systems wiew
Run As 4
Debug As | 2
Profile As 4
Team »
Compare With 4
Restore from Local History -
Properties Alt+Enter '
: T
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FEONE B HAAT R A7

ESM7000 T 4% 3= A4 FH 06332

TR TR SO RS A -

'~ ERR .

B AR 212 AL

WG R RAR AR, &P Delete,

[,;j‘\_j Prgggct Exg}orer S;?, J

=

8 @ stepd_tepeclient. cf

=9

&
=< | @

[ |

- | }TCECLIENT_IN

@ =% hello
- 100 LCD_API

: ] lstartup
10 Stepl_LCD

(= Debug

- [h| TCPCL

# 2% Stepl_LCDTest

i 0] Step2?_SerialTest

107 Step3_TCPServer

=25 Stepd_TCPClient
& f;’ Binaries

= Release
[ @ step4_tepclient. cpp

* TepClientl

o e e e e el ol e

/'&"&'
TCP Client

This class
functions -
It is also

*
*
*
*

*

» i

& [€ TepCl
[ [h| TepCl

Open
Open With

L1

Copy

() Paste

Ctrl+tAlt+Shifi+Down

F2

FS

Exclude from build. ..
Index

Build Configurations
Make Targets

L=t |

Clean Selected File(s)
Build Selected File(s)
Team

Compare With

Replace With

HikiText

v v v v

==
<

Properties

Alt+Enter
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3.5 eclipse T4Pk C++NFTHE

TRESCAF it 5E R, WUE eclipse IDE M85 T BLIEHEAT G B 25 B MR AT AT ST

1t Project Explorer & H N8 75 2 4m 310 TR SO, a0 Rk Step4_TCPClient T

T2, R sk H R Project -> Build Project BIRTEATFET 14 7

R IR R
VEPEN ) TR 4w 3 ) Debug CEARAS) 1 Release (KATHIA). fE Project Explorer
PG T, £ Z R TR, S8 )E i BAs 4 B, 164% Build Configurations -> Set

Active -> Release T, &~
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HE RO EBAREIRAT ESM7000 T AR {11 04 52

\f[j Project Explorer o3 ; = O ¢ stepd_tcpelient. cpp | [€] TCEClient. cpp 53 ‘ €] TepClientManager. .
| & e return 0;
- 74
1% hello .
£7 LCD_APT | D
ol /rolB
£ Stepl_LCD res = pthread attr init (gattr):
2 = =
= if =0
O] Stepl_LCDTest :' [ LES !
L] Step2_SerialTest g : .
L7 Step3 TCES printf ("Create attribute failedin" )
ep3_ erver m
B H . ‘
: Hew » Si,ﬁ I)i
Go Into d_attr setscope( &attr, PTHREAD 3¢
B
Open in New Window ad attr setdetachstate( &attr, PTI
{2 Copy Ctrl+C
Fy Laste "Setting attribute failedin" ):
¥ Delete Delete
Move d create( &m thread, &attr, (void
Rename. .. F2
22y Import. .. sockfd )’
£y Export. .. H
Build Project
Clean Project . destroy( &attr ):
2 | Refresh F5
Close Project
Close Unrelated Projects b =
B ] Console 52 | =l Properties
Exclude from build 8 =
Make Targets 4 Build 4l v 2 Release
» e i g
Index =cated bBhnve
Show in Remote Systems wiew Manage. . . op!
Convert To...
Riisne y step4 TCPClient'
K ; ;
Dibig s > G++ C++ Linker
3 abi-g++ —-Xlinker -Map="Stepd4 TCPC
Profile As 4 o
- target: Stepd4 TCPClient'
Team » i
Compare With 4

g A e

o R IR E
BCE N TREG B JE Ik, AESERRN o A5 LEA 2 (2 B AR AR 22 Link & H (22 5L
P, U 5 20 CIC++A G 1B & P EAT AR L (1 1 B

7t Project Explorer ML ~, G#HEFREWRE N TR, NEmdilina s, g5
Properties i, 7£ & I 3% % C/C++ Build -> Settings -> Tool Settings -> Sourcery G++
C++ Linker -> Libraries, W FEfix. KA —AN% OH TR E X4, —MHET
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H OO B AL RAR ESM7000 L #% 1 fi it /i 2 ¢

FRE PSR IBR AR, X R G ORI PESC, A /e 28 AR TR T & 2 S
s DN FE B E A2

Properties for hello

type filter text €| | Settings & v o -
* Resource Configuration: Debug [ Active] ~ ||Manage Configurations...
Builders
= C/C++ Build
Build Variable ® Tool Settings | # Build Steps Build Artifact Binary Parsers @ Error Parse‘%:ﬂ_:liﬁbn
Environment - ® GCC C++ Compiler Libraries (-) B 8 &
Logging & Dialect
Settings & Preprocessor
Tool Chain Ed #Includes
- C/C++ General EOptimization
+ Code Analysis & Debugging
Documentatic &Warnings
File Types & Miscellaneous
Formatter - ® GCC C Compiler
Indexer & Dialect
Language Ma & Preprocessor
Paths and Syr &symbols
Preprocessor #Includes T oot el e R
Project Referen & Optimization
Run/Debug Set & Debugging

EWarnings

& Miscellaneous
~ ® QCC C++ Linker

& General

& Libraries

& Miscellaneous

&Shared Library Settings
- ® GCC Assembler

& General

Restore Defaults Apply

@ Cancel OK

BE R

FEHEAT Linux NZAIREFPIT A, WNAERA T 2 ERENHRAE, HATHPEAT, w2 I0Lefe s
libpthread N EIFEREILT . VER, 1E GHAREMI B 5B A BERE L% .

S PR e 75 B VB PR O S P, 0075 B 2R B S AT
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3.6 WEXHRGER

PP AEIT 5 WU 58 A L PR Py il A0 L — 5 [ 592 203 ESM7000 (47 if a5 5
A REHHATIZATINR . XM RHIRINEA RS, T A R B S RS, 7k
R RLRET R ML P 8 E 92—~ H S48 ESM7000 [ Linux Herb, 3XFE, P
TER N TE RN RE el o] DB 2 H ok R, SRR BB 4 2 11 H A2 ESM7000
EREATIEAT I

1. NFS {2 B s, R 2N, WEEL%FE%?, RN A
GERIERANEL ZZ R, IR IEIE I E ST Linux WA i B EAT 22 4%

. nfs-utils-* . GFFEILARN NFS i 45 RiEET
. portmap-* : (%4 NFS RPC IR 45 (iR

2. MCE NFS. NFS JIus5% ImC BAXS LB 5, A R SR A B A C B SO h b A7 5
B, E)E3) NFS RS0,

NFS R4 IR E XN letclexports, XANSCHF2 NFS I EERLE A, AL RGH
BABRME, PRSI —E 2 A7AE, FREEAEN vim Fahdar, RS/ ELINS
UNW=ALESR

letclexports SCAH A 7 4% 2

<fth B> (% 0 1 eIt CUp RBLR P s, FeAd) ] (%) o 2 1830 (5 IRIALRR,
R s, HiAds) ]

a. i H
fth H AR NFS RS e 23 5 P AL ) H 5%
b. % i
7 SR AR 2% R DADT I XA NFS fart H sk i THEL
5 i AR 4E E 7 30

R 5E ip HIhER FHL: 192.168.0.200

& T FTA EML: 192.168.0.0/24 192.168.0.0/255.255.255.0
feE 4 M EHL: david.bsmart.cn

fa eI BT A ML *.bsmart.cn

Bl L *
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c. iETi:

IR R v B A H SRV AR R U A

NFS 247 3 KL

VTR A PR 36 5

BB H R ro

wEHHEARES: w

P Wdp 26350

all_squash: K26 F2 1y il (¥ i 47 5 38 P K B Je ZEL 8 e ik g B 4 L P sl H - 4
(nfsnobody);

no_all_squash: 5 all_squash Bz (ERIAE);

root_squash: ¥ root H /7 S i & 2L i i B 44 FH P B P4 CBRIAVIRCEDDs

no_root_squash: 5 rootsquash HUx ;

anonuid=xxx: Kz U5 vl (¥ FTE F - #MUR A A R, R iz O A
J1 (UID=xxX);

anongid=xxx: WFZEFEVs 0] [ FTA F P AL N EE 2 H P Ak, I FR e i E 4
F P ALK PO AR ALK P (GID=xXxx);

He 0

secure: PRIZ i S B8 /T 1024 1 teplip Ui &R nfs IjRS548 (BRINIRED;

insecure: RVFE i T 1024 1) teplip b 1 ZEE IR 55 5% ;

sync: KR E NN IX SRS, BERAG, (HA] DUORIIE 200 i —250rE

async: K S ORIFAENAF 2P X oy, A BRI A 5 N AE s

wdelay: A2 B AR BERIE, WA NI EIE AT, XL
fEeE (BRARED;

no_wdelay: #74 5HA/EN L EIFAT, N5 sync Fl& 1

subtree: Zfiit Ha— 7 H3t, W nfs M55 4R HAZ H SR BUR (BRI
H):

no_subtree: Bt Hx2— 1T HX, nfs k% a AR EHACH SRR,
XA AT DASE e RO s

i B 472 J5 A 8l NFS AR5
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#sudo service portmap start
#sudo service nfs start
e BT EATECED K, BT Linux E£ERARE, FMEHA—EXH, W
R NFS #5384 7] T AR R L A48 2 A BTk
3. Hik userinfo.txt SCAFCRCEFIFAEA U AL, H U 8EAE T R USB #H1 |,
I NARG L. HKEIE ESM7000 EONIT R EHLIEE RIHE AUE/Imntinfs, K, 1R
g fE 4 cd /mntinfs #EA nfs 3%, Mm@ 1s -| &F, WHEZDFAEN L
public ST HRIAE, N EFR, RoaREENRI.

root@ESMES02: ~# mount -t nfs -o nolock 192.168.201.82:/svn/d/public /mnt/nfs/
root@ESM6802: ~# ls /mnt/nfs/
123.wav

3.12

Getting Started

LICENSE. iwlwifi-6000-ucode
NK

0t-5.6.1

0t-5.8.0

README. iwlwifi-6000-uccde
SPL

am335x-esm335x.dthb

AR Linux B3 NI R BN ISR

A AR HUERCBOA BRI B (] e b i, iU B 2ERE, A5 Tl Ay
L REATHER:

mount —t nfs —o nolock 192.168.201.85:/d/public /mnt/nfs

bl A & AL E A ], T RBES H BRI R ENL 1P sk RIS
PIEB

5. WIRHEAI IR AN, BRI A TR ER, AEHRIN. FEEMZ, RfA
R 55 48 B B KR BRLE

L IXP R4, ESM7000 FIBBET A B B 58, 8N R AT BLEAT
NIRRT T
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4 MHAEF@WELHZ—: BOER

ESM7000 $24t T 6 Mt . ttyS1. ttyS2. ttyS3. ttyS4. ttyS5. ttyS6, H:
H1 ttyS5. ttyS6 FI GPIO (MG, AN OHA ISP, 248 D ae
IR SR AT RO . &8 OIS DA & 7E Linux #E RSP Z+, ESM7000
fE Linux RS8R BN5ERN, & H EAEN PR BE% 58 BT iEMHma, - B9 AR 7l BA
DA SRR 7 200 R CUBEAT 325, AT SR SO R Dh RE -

4.1 BOHREBEORE

76 Linux 9, BT & SO T4/dev’ H &, ESM7000 75/ 5 TG R 15
# S MR A “IdevittyS1” . “/devittyS2” . “/dev/ttyS3” . “/devittyS4” . “/devittyS5” .
“/devittyS6” . ttyS1 —ttyS6 ¥ mEnE A 1, HkFrEnlik 3Mbps, HAEAI 8-bit, CHFAET
B K. MARK / SPACE # & .

FE Linux RERVEBLA 177 RANERAE SO K07 20 —FE, A open( )T FF 84 3L,
PRI read( ). write( )Xf e FUEAT BRI S #E . X B R EVERIRAT T 8 DB T i E
WS 24k, EFERLE O NOCTTY Ml O_NDLEAY, LU iZ 8 1 oA — M 4 i,

A e B - R . e

sprintf( portname, "/dev/ttyS%d", PortNo ); /IPortNo Ay it 1145, M LTF4G
m_fd = open( portname,O_RDWR | O_NOCTTY | O_NONBLOCK);

TR R MBI 7 B IE NS B E, OREArR . Rl Fib6. RS
o ESEPRIERIET, FERIEIE B E struct termios £5 HMA IR & AN B ME R LI, — s
BRI PSE QDR AR

tcgetattr() ;
tcflush();
cfsetispeed();
cfsetospeed( );
tcsetattr( );

Www.emtronix.com 30 028-86180660




B OROE B ARG IRA T ESM7000 4% 3= A I 0612

Forh A s B AR 520X A —— Al T, AP AT LS % Linux MR 7K
(A48, T 2F Step2_SerialTest i Serial.cpp #iHtr set_port( )& LS
42 BOZaNARH

Step2 _SerialTest /&N 3CHF 5720 8 LERE 7R 61, Z GBI 1 T [ R IK C++
Gk, TR OBERE AR — R RBEATEE, F I A Z0 SR AL AR O e R a7 (3
e R TR TR R A

CSerial BN
FIH E— /N AHr 8 0 APL B3, 325 7 — R b5 8 M2% CSerial,
CSerial Mt T 4 DN AIERREL. — 8 D5 R 268 UL R #2UOH 2 i 4dE Buffer,

class CSerial
{
private:
IHBREFEARRFFID
pthread_t m_thread;
I R BRI AR
static int ReceiveThreadFunc( void* Iparam );
public:
CSerial();
virtual ~CSerial();

int m_fd; 11 EFTIT I A SO R 7
int  m_DatLen;
char DatBuf[1500];

int ~ m_ExitThreadFlag;

I ZHEHR R E O SEETTTHR O, JREIE R DB &R

int OpenPort( int PortNo, int baudrate, char databits, char stopbits, char parity );
11 SR P e 1 FERE TIOR8 B R

int ClosePort( );

I T S

int WritePort( char* Buf, int len );

112 e 11 B A 3 g

virtual int PackagePro( char* Buf, int len );
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OpenPort REH TR S OSHETIF RO, IR S D8RR, 7£ Linux
M8 rh 2L 5 % pthread_create( )BIHEZERE, @it pE%L pthread_exit( )iE HZEFE. Linux
LRERMAAAEA DB (B M EPM, EAESBEIERT, B DMERRERN, ey
R RS G BRA ORI, Wl & B IE 2t R A pthread_join( )& ok (=],
QRIS BERIE O 5B BRI BRI, — MRS RN L RVBERUT & &
GRotUR. FETIXANRE, FEFRATHR A 05 R i A S pR BOR B F AR 1 S M B E O o)

Btk
Il WE ARG E R
res = pthread_attr_setscope( &attr, PTHREAD_SCOPE_SYSTEM );
I WEETE T IR
res += pthread_attr_setdetachstate( &attr, THREAD_CREATE_DETACHED );

ReceiveThreadFunc R #0 B 11 80408 YSOM b PR 32 ZEAZOAXAD 7212 60 % i
select(), PHZESFARER CIEURE AEIR . X T HW I A0 Ab 21 2 A2 R B S, AEARR
R rp A FE O fa] SRR [0 A, TP W45 S Bn i S AB e A AR, 22k PackagePro( ) ek
HEIAr. AR

SRR AR

»
|

\ 4
Ao
oA
et
=
LA
HO

select (&5 1F

PR SRR LS

MR I A EE

v

5 LR A

int CSerial::ReceiveThreadFunc(void* Iparam)

{
CSerial *pSer = (CSerial*)lparam;
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15 s
fd_set fdRead;
int ret;

struct timeval  aTime;

while( 1)
{
IMSCENR HF 1, SRR
if( pSer->m_ExitThreadFlag )
{
break;
}
FD_ZERO(&fdRead);
FD_SET(pSer->m_fd,&fdRead);
aTime.tv_sec = 0;
aTime.tv_usec = 300000;
ret = select( pSer->m_fd+1,&fdRead,NULL,NULL,&aTime );

if (ret<0)
{
EZEA.!
pSer->ClosePort( );
break;
}
if (ret > 0)
{
AR A B A
if (FD_ISSET(pSer->m_fd,&fdRead))
{
/ldata available, so get it!
pSer->m_DatLen = read( pSer->m_fd, pSer->DatBuf, 1500 );
11X RS A AT AR EE, 3 L A 7 SR A s 1R
if( pSer->m_DatLen > 0)
{
pSer->PackagePro( pSer->DatBuf, pSer->m_DatLen);
}
Il Ab i 5 e
}
}

}

printf( "ReceiveThreadFunc finished\n");
pthread_exit( NULL );

return O;
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i BER I, select( )AL N RIS Linux F, SROCHNTH ZEBIRE, S
H31H 0.

CSerial 2552 BACHIGE 2 I Serial.CPP (44

CSerial 8/ H
CSerial ZE1 B4 WM LR M B, BT 2w X 4 M ASLRERA, LR
Ny Step2_SerialTest.cpp HHHKALHT

class CSerial m_Serial;
int main( int argc,char* argv(] )
{
int i1;
int portno, baudRate;
char cmdline[256];

printf( "Step2_SerialTest V1.0\n");
Il fENTE AT S5 R OS BRE

iftargc>1) strepy( cmdline, argv[1] );
else portno = 1;
if(argc>2)

{

strcat( cmdline, " ");
strcat( cmdline, argv[2] );
scanf( cmdline, "%d %d", &portno, &baudRate );

else

baudRate = 115200;
}
printf( "port:%d baudrate:%d\n", portno, baudRate);
IHTITH DU SRR 3 1 e D Bl i 2 s
i1 = m_Serial.OpenPort( portno, baudRate, '8', '1', 'N);
if(i1<0)
{

printf( "serial open fail\n");

return -1;
}
IBENTEEH, X HAERLIshh —MERER
for(i1=0; i1<10000;i1++)
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sleep(1);
printf( "%d \n", i1l+1);
}

m_Serial.ClosePort( );
return O;

M LT RS AT A Y R I AR A 75 ZE Sl LA B I Th R, AEAS B RE P LAY
R 1s il — MEREE, ESEPRRIN T, AT PEE g N AR R BT
AR PR A SRR AT AE LRI, XAEFE A T Linux ZAE55 IgFEI0, A A BIE S5 R
FENLED, R SR DAL, DME TR M ih AV B X BUBE AR — 1, T2
AR OgRAER, A AR AGIRE ) CSerial 2893438, R4 N FKIR4EZ > CSerial
IR, B —NRAER R R EFSCHLRE K%L PackagePro(...), XFEEEA R ARG —

ANIRSZ A H RO A B2 RS, A Linux ARX AR 55 18 EEA LR DLSEE 2 &R s IR fRE -

Step2_SerialTest K4miFiE

FEZGIRE T B T RFRAE R, T EREEANREE, eclipse wiknT LU, H
72 link 2 i, FEME eclipse IDE M4miFZ4L, Linker FEiE g MR E. £ Project
Explorer #% T, i%#¥ Step2_SerialTest TR, A5 m i RbrA 8, % Properties
T, {E% 0rhi%$ C/C++ Build -> Settings -> Tool Settings -> C++ Linker -> Libraries,
IR E PR i —ANE D T B iR, — MR E R AR, X TR
Girh A LA Ipthread SO, AN 5 24 € B A2

5 MAERHREERZ—: TCP RE%H

PAK I TE RN SR S AR T3, 76 LA U0h LU0 H WL 2 ) TCPAP Hrill
BEATHCE @ . ESM7000 A 10M/100M H3& B 4 82 1, JEH & F TR 9 2% 52 H (1 7T
KV G. FEMGRHIT, HWIERAIUNEE, £ARTEEESNY ESM7000 14 TCP ks
J7 N H——C FE 2 %82 1) TCP k%5 83 ~ilF2/7: Step3_TCPServer.
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5.1 TCP Socket 458

FESEAT W26 N IR P O 505 T K 2 2R BT Socket BOR, Linux RS & LB
FEtnit . Socket 4w HFEA R HA socket( ). bind()- listen( ). accept( ). send( ). sendto( )-
recv( ). recvfrom( ). connect( )%, #/NERETIEAMH AR ERA——NHT, H
" AZ% Linux BT 7T R BOAR G T4

5.2 XHEEEN TCP RSN ARG

Step3_TCPServe J& — MR 2% Uit i%E4: TCPServer 7w, 1ZBIFERA T 7
XTI C++4ife, QE T CTCPServer fl CTCPCustom P43, Mt CTCPServer 24
WU R, — BR R G ROERE, et St g R, R — AT
CTCPCustom X1 4 5% /i EA T, S8 5 CTCPServer S84 il % 7 s FRIZE R 17 K

HIRR R

- __»l CTCPCustom [* ™ TCP %/ 1
r=-» cTCPCustom [¢ P TCP % itk 2
i __a] CTCPCustom |¢ J| TCP &/ 3
CTCPServer |.F~ ¥ = d &
L __» CTCPCustom [* ™ TCP % /i n
CTCPServer 2%

CTCPServer K& X{E TCPServer.h SR, R4 T 3 MALERE, PLA—

Socket il £ FE, AR+ Open(). Close()H T Ja3hEk 2 %M TCP iR% .

www.emtronix.com 36 028-86180660




BRI B ARG R A A ESM7000 .45 3t i FH st

class CTCPServer

{
private:
pthread_t m_thread,; I IR FERR IR TFID
11 SocketfiiWT £k F#
static int SocketListenThread( void*lparam );
public:
int m_sockfd; /I TCPJik45 HiMrsocket
int m_ExitThreadFlag;
int m_LocalPort; 11V B R vt 115
CTCPServer();
virtual ~CTCPServer();
int Open(); Il TIFTCPIR %
int Close(); Il FHITCPIR %S
IR — A% P i RaERe BCHR
int RemoveClientSocketObject( void* Iparam );
I3

1EOpen( ) A sLHL T H EH T, WERFRENNTERET, @M & b
TERLRAE . TELinux b HFE 7 rh B LR FE I T VETE“D.2 o LSR5 N R B o AH SRR i B
TEZMIFE 2 R R R 75 5K

SocketListenThread &% %7 i Flselect( )i %/ 3w (O TCPIERE, WAL R -

SR s

\ 4

e IR AR >

Y%:

select( )&%

accept ] CTCPCustom X} %
J& 3)) CTCPCustom #j#i il inZk 7%

[FIRER R 2T R 2, select( ) pf B B 8] ZH07E Linux R RERCER R 2 BRI, &

Www.emtronix.com 37 028-86180660




HIOSLAE BEAH AT ESM7000 4% TR A FH 0152

M4 H3h)4 0. CTCPServer Z5HsIARAL1E S I TCPServer.CPP (44

CTCPCustom3k

CTCPCustom[t] € X fETCPCustom.h 34T,

class CTCPCustom
{
public:
CTCPCustom();
virtual ~CTCPCustom();
public:
char m_RemoteHost[100]; I @R E AP
int  m_RemotePort; 11 R AL 115
int m_socketfd; /I i@ itlsocket
int  m_SocketEnable;
int  m_ExitThreadFlag;
CTCPServer* m_pTCPServer;
private:
I BT R A
pthread_t m_thread:; I B HEFERR IR AFID
static void* SocketDataThread(void* Iparam); I TCPIE 44 18 H L 2
public:
int RecvLen;
char RecvBuf[1500];
Il $THsocket, filziH LR
int Open(void* Iparam);
Il Klsocket, KHFIZEFE, FEifSocket s
int Close();
I TR 5 2 i 32 H 4
int SendData(const char * buf , int len );

H ) SocketDataThread Bf%/E S2Hl TCP ERERH M N A% O, 761% sk B0 i
H select( )& £F TCP ERZHIEIREE, X T80/ TCP 8500 1 Ab 3t 2 78 1% o B s
I, FEAGIFE AP AL A AT BB 9Dk, P AT 45 4 SEBR A N S SO AR AREY, JRFE AR
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SR A

[
»

select( )55 15

T B

recv ()EEEUEHE

Ak 3 A

CTCPServer 2K H

CTCPSerer S AARME B ELEL T 2, EEORIHHIN T-2rhE L Open BI#CKE 30 %
A TCP EHEARE, R FEA T FELIWIRRINAZ T, ARG ERRE 1s
W IRREE. LU NN Step3 _TCPServer.cpp H HAH A .

class CTCPServer m_TCPServer;
int main()
{
intil;
printf( "Step3_TCPTest V1.0\n");
Il 5 TCP R 5 i i G AE
m_TCPServer.m_LocalPort = 1001;
Il G Socket, Ja B TCPRSs s il £k 2
il = m_TCPServer.Open();
if(i1<0)
{
printf( "TCP Server start fail\n");

return -1;
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}
I BENEEIR, FERMFTEETE
for(i1=0; i1<10000;i1++) I SEBRR B, 773 E A TCBRIG
{
sleep(1);
printf( "%d \n", i1+1);
}
m_TCPServer.Close();
return O;

Step3_TCPServer K% Fi&E
T 2 Linux 142088, RILASE] Y Step2_SerialTest SEFIFE 7 —HF, 75 ZXT
BRA Mg E R B TE N, BARTEIES 5.2 & DA N HRGIE RN 2 .

6 MHBFRELEFIZ=: TCP Z& "4

A EE B 44 ESM7000 £ TCP % )7 i /7 UK B FH 7~ 19 Stepd_TCPClient.
6.1 TCP &/ % Socket RiERE
EF|H Socket #H4T TCP & Fumém ey, #HS. TCP ERRE — R ILEM H, HA%

Fin i F socket() s Ed rin ANERE T, AR5 A connect() B #iE SR ARk &5 2l 2 37 TCP i
2, RO SLER S RIPT 5 IR 55 48 i AT TCPAP Hdfd i, R T
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socket

bind

\ 4

connect |

v

send

recv

close

6.2 TCPClient N~

Step4_TCPClient 2 —/MHA AN EBLIIRER TCP % i N 7wl 158 TCP % i
FBNHINRSS A L. TCP IER IS A2 g AR (&1 58, BB A AHOCH) Socket pR#RIHT,
AL TCP #E L Re £ 2E7E CTCPClient 281 IR AXKIN A& RZ 24T KYHE1T
MNESFHPRES, FRES BRI FH B — HARF TCP % & 1E L, Stepd_TCPClient |2
FT IRk, L1E% 7 —4 CTCPClientManager & ¥ 3$%f TCPClient 43T H 3)
EH, QAFEsE TCP MR M umiEs:. Al TCP EBIIRE. WinZ A TCP & /7 i i%

EAEIIRE .

CTCPClient 2K
CTCPClient 245 X 7F TCPClient.H X, ZIRM4L T 4 DNASLREL, PLE— /s iE R

2, WHNZRT MRS TCP e ss s i L

class CTCPClient

{

private:
pthread_t m_thread; 11 B FERRRFFID
11 R I TR AL B2 bR 3
static int SocketThreadFunc( void*lparam );

public:
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/| TCPiH HSocket

int m_sockfd;

int m_sockclose;

int m_ExitThreadFlag;
11 IR EHLIPHbE

char m_remoteHost[255];

1 SZEFE A ML

int m_port;

char RecvBuf[1500];
int m_nRecvLen;

public:
CTCPClient();
virtual ~CTCPClient( );
11 $T T B3 % /™ socket
int Open( char* ServerlP, int ServerPort );
Il K% Fiisocket
int Close();
I 55545 vm i S IR I A B I TR AL PR AR
int Connect();
11 TR IR 5% 4 i R ALK

int SendData( char * buf , int len);

Open B UIIAT AUEFTIT socket #iff:, Jf i B TCP IRk 55 &) 1P Al .

Connect ¥ %01 H connect( )5zt TCP k5w i L&z, WH select( )54 TCP &
RIS, TCP ERELKY), WEIE TCP hiE il B L e .

SocketThreadFunc iR %2 528 TCP HEH ¥4 id W K A% 0 A0S, 72 1% s B0 i A
select(), %4F TCP M MIE A, X THUH TCP 3E R i A P R 75 % R B b sk
P, AEAGIRE p AL BN 7 B0 OB (B, TP AT &8 & SRR S PR B SOt AL AR o RN T

Www.emtronix.com 42 028-86180660




BRI B ARG R A A ESM7000 .45 3t i FH st

SR A

[
»

select( )55 15

T B

recv( )EEEUEHE

Ak 3 A

CTCPClientManager &
TCP & 7 tigide 2 S PYANIRES :
enum CONNSTATE{ csWAIT, csINIT, csCLOSED, csOPEN };

Hd csOPEN %] TCP % J' i e g 7.

CTCPClientManager Fit} 2% i) Dy RE R HU 2 AR 1B B AIRE XS TCP % /- e %2

#4TH#, CTCPClientManager 25 X /£ TCPClientManager.H T .

class CTCPClientManager

{
private:
/I TCPClienti 4 4 # 4 2
static int TCPClientThreadFunc( void* Iparam );
public:
TCPCLIENT_INFO m_TCPClientinfo[ TCPCLIENT_MAX_NUM];
pthread_t m_thread[TCPCLIENT_MAX_NUM];
int m_nTCPClientNum;
public:

CTCPClientManager();
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~CTCPClientManager();

Il INTCPZ iR 5, AN S HONTCP I 5545 1P A3 11
int AddTCPClientObject( char* pHostIP, int nHostPort );

11 Wk BT TCP 2 7 ity JEE H250F 42

int DeleteAlITCPClient( );

I BLETCPZ /7 i 40 B esINITIR S

int Open(int Idx );

11 FRETCP % ) i EHR A&

int  GetTCPClientState( int Idx );

Il JA S TCPClientiE 8 B, I G TCPClienti& & FLLL %

int Start();
Il <A TCPClienti /2 B 5 /F
int Stop();

TCPClientThreadFunc B0 SEIN TCP EEERAE HRIE 2 0AREY, BT Linux
'~ sleep I/ NANINED, W T2 RNAER S5, EIZRECH AR select( ) BEEMX
R TR Z Bk S . AR T

SR R

»
|

re IR H 2 A
/

ConnS==csWait

select( )5 1F

csINIT

> CTCPClient::Open()
csCLOSED

> CTCPClient::Connect()
csOPEN

P| s %O B
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CTCPClientManager 2814

CTCPClientManager K EAMHIIRE: & /EIHAZESF E X AddTCPClientObject
BTCP ERN R, MR HMZHE X Start IMECRE3) TCP &4 A3 E HLRE, Open B
el TCP DR E Y csINIT RZES . AGIRETH E0EFIEAE A& 1s &l TCPClient
ERRPIRE, WHARES N csWait, FEFHH Open R0 H B E A csINIT JIRZS, U TCPC
B PR F AT S TCP IRSS# ity L E LI 4R

PL N A Step4_TCPClient.cpp 1 IAH AU .

class CTCPClientManager TCPClIntManager;

int main()

{
intil, i2,i3;
Il IRIN—NTCPZ P i A0t %
TCPCIntManager.AddTCPClientObject( "192.168.201.121", 1001 );
Il JAEN TCPClienti& i Bl A, Jf B TCPClienti& i s P22
TCPCIntManager.Start();
for(i1=0; i1<TCPClIntManager.m_nTCPClientNum; i1++)

{
I WCETCPZ Ui E I ARIRAS, A AR 5 3 AT TCP R E B R AF
TCPCIntManager.Open(il);
}
for(i1=0; i1<10000; i1++)
{
sleep(1);
for(i2=0; i2<TCPCIntManager.m_nTCPClientNum; i2++)
{
Il ERTCPZ 7 i HR A&
i3 = TCPCIntManager.GetTCPClientState(i2);
printf( "TCP Connect%d State: %d \n", i2+1, i3 );
if(i3==0)
{
Il CETCPZ Ui E IR IRES, B ARG B s (T TCPEE AR A
TCPCIntManager.Open(i2 );
}
}
}
return 0;
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